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In-Sight ViDi Standard Section 1 | Lab Exercise

At the end of this lab exercise, Participants will be able to:
e Connect their In-Sight camera to the network
e Create a new project

The Participant will utilize the following In-Sight Functions to successfully complete this
exercise:

e Connect button

e Job Wizard

Follow the steps below to connect to the In-Sight Camera:
1. Create a folder on your desktop named ISVSClass with the date appended, e.g.,
ISVSClass012720. This is where you will save the jobs you will develop in the lab
exercises.

2. Double click the In-Sight Vision Suite shortcut icon on your desktop.

g@o

In-5ight
Vision Suite

The In-Sight Vision Suite Launcher will display. The In-Sight Vision Suite pane
displays the host names of the discovered controllers, as well as icons that indicate
the model and current state of the controller.

NoTE: When the launcher first starts, it will discover and enumerate all of the In-Sight
Vision Systems on the local subnet network in the In-Sight ViDi System pane. In this
example there is an In-Sight Vision system and one emulator that have been
discovered on the network.

E‘a In-Sight Vision Suite N

USNA-2313-1064 System Info
In-Sight ViDi System
L' isd905m_Jennifer
In-Sight ViDi System - Emulator

5 usna-2313-1064 (This PC)

HTTP Port
Current Job
Startup Job

.
Connect

3. Click on the name of your Vision System and click the Connect button.
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In-Sight ViDi Standard Section 1 | Lab Exercise

The Loading window displays.

Loading

The Development Environment displays. Notice a second tab representing the
blank spreadsheet displays.

2 in dlae s BER B (]

Toolbox  Web Pages  Templates

(@ Successhl deployment
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In-Sight ViDi Standard Section 1 | Lab Exercise

Connecting to the Emulator
Follow the steps below to connect to the Emulator:

1.

Create a folder on your desktop named ISVSClass with the date appended, e.g.,
ISVSClass012720. This is where you will save the projects you will develop in the
lab exercises.

Double click the In-Sight Vision Suite shortcut (software version) icon on your
desktop.

gdi

In-5ight
Vision Suite

The In-Sight Vision Suite Launcher will display. The In-Sight Vision Suite pane
displays the host names of the discovered controllers and emulators, as well as icons
that indicate the model and current state of the controller.

NoTE: When the launcher first starts, it will discover and enumerate all of the In-Sight
Vision Systems on the local subnet network in the In-Sight ViDi System pane. In this
example there is an In-Sight Vision system and one emulator that have been
discovered on the network.

E"Z’ In-Sight Vision Suite

USNA-2313-1064 System Info

In-Sight ViDi System

! usna-2313-1064

L. isd905m_Jennifer

In-Sight ViDi System - Emulator

+  usna-2313-1064 (This PC)

HTTP Port

. C
Conr

3. Click on the name of your Emulator and click the Connect button.
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In-Sight ViDi Standard Section 1 | Lab Exercise

The Loading window displays.

Loading

The Development Environment displays. Notice a tab representing the
spreadsheet displays.

& nsleaa BME NG (@D
=

Templates
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In-Sight ViDi Standard Section 2 | Lab Exercise

At the end of this lab exercise, Participants will be able to:
e Create a new project
e Insert Absolute and Relative references into a spreadsheet and observe the
differences

The Participant will utilize the following In-Sight Functions to successfully complete this
exercise:

e Connect Button

e Job Wizard

e Absolute and Relative References

Follow the steps below to complete the lab exercise (using your camera):

1. If not connected to your camera, select your camera from the list of cameras and
click the Connect button.

The Spreadsheet view displays.

[33] In-Sight Vision Suite ) [Unsaved Job]@isd905m_Jennifer X

File Edit View Insert Format Image Job Tools Network Help
Bl €2, @Veify D Online _

E Main Spreadsheet X

BE Noconfigurationwasioaded. . W B S @M@ 7 T L2  h & G EE R M £ 2 HFRPE A
~ Arial ve vIBI/IEETS 8N -
BE & ik || E Image ~ = Acquirelmage()
A | 8 | ¢ | o | E | F | 6 | H | J K E
npPImag
1
i
g
2. Click the Live Video button to start a live image.
3. Move the part under the camera to confirm the image is updating.
4. Click the Live Video again to stop the live image.
5. Double-click cell A0 to access the camera settings.

B | ¢ [ D
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6. Adjust the Exposure setting to establish light and dark pixels.
NOTE: Increase the exposure setting for a lighter image.

Spreadsheet - Property Sheet - Acquirelmage

Edit Insert Help

(7Y

Trigger Mode Continuous

Debounce (ms) 0.500
Delay (ms) 0
Exposure (ms) 8.000

Offset 0

A,

Click the OK button to close the camera settings.
8. Click the Change Split button twice to split the view.
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In-Sight ViDi Standard Section 2 | Lab Exercise

9. Click the Show Image Saturation button to verify the writing on the block is dark
and the metallic background light on your image.

NoTE: Too much blue means that the image is too dark and too much red means that

the image is too light. To remedy this, adjust the aperture setting, exposure or light

control (LEDs).

10.  Click the Save All B button to save the job.
The Apply Changes dialog displays.

. ¥i .

11. Click the Yes button to continue.
Apply Changes
Apply changes to the following items?

Spreadsheet

Cancel

12. Save the job as MyFocus in the folder that you created in Lab #1 and click the Save

| htton.

Location: | C\Users\jmacdona\OneDrive - Cognex Corporation\Desktop\|SVS_Class_03.05.2020

Name Date modified

Downloads

e

Network

3
L2

File Name: | MyFocus

Available free space: 352 G Save Cancel
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In-Sight ViDi Standard Section 2 | Lab Exercise

Absolute References

Follow the steps below to complete the lab exercise:
1. Click the New Job button to begin a new job.

The Job Wizard displays.

NoTE: We will not be using an image for this lab.
2. Enter MyCells in the File Name field, save to the folder created in Lab #1 and click

the Finish button.

File Name: MyCells

File Path: Chlsersy Desktop\ISVY5Projects012720

File Location: () On Device (@ On this PC

Meut ‘ | Cancel | | Fimish

3. Enter a value of 1.0 in cell A2.
4. Enter a value of 2.0 in A3.

5. Enter a formula into cell B2 that adds cells A2 and A3 using Absolute References.

A | B | A | B |
_Ell:llmage ) _Ell:llmage )
1 _—
2] r.o00] sas2+incd _ 3| tooo[ 3000
3| 2000 3| 2.000

Relative References

Follow the steps below to complete the lab exercise:
1. Enter a value of -1.0 in cell A5.

2. Enter a value of 4.0 in A6.
3. Enter a formula into cell B5 that adds cells A5 and A6 using Relative References.

4 4
s -1.000] A5+ 5| -1.000 3.000
B 4.000 B 4.000
7 7
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In-Sight ViDi Standard

Copying and Pasting Relative References
Follow the steps below to complete the lab exercise:

Al A

6.

Highlight cell B2.
Copy and paste it to cell D2.
Highlight cell BS.
Copy and paste it to cell D5.

Section 2 | Lab Exercise

Examine the formula in cell D5 and compare it to the original formula in B5.

How do they differ?

Why do they differ?

Why is cell D2 showing a number?

A | B | © o |
0{Olmage )
1
2 1.000 3.000 3.000
3 2.000
4
5 -1.000 3.000 0.000
B 4.000
Click the Save All El button.
The Apply Changes dialog box displays.
Apply Changes — O
Apply changes to the following itemns?
Spreadsheet
Yes Mo Cancel

7. Click the Yes button to close the dialog box and save the project.

Page 11

COGNEX



In-Sight ViDi Standard Section 2 | Lab Exercise

Page 12 COGNEX



In-Sight ViDi Standard Section 3 | Lab Exercise

At the end of this lab exercise, Participants will be able to:
o Utilize the PatMax RedLine tool to locate the Cognex logo in the Field of View
e Report the location based on row, column, and angle
¢ Apply the location information for fixturing in other vision functions

The Participant will utilize the following In-Sight Vision Suite Functions to successfully
complete this exercise:

e TrainPatMaxRedLine

e FindPatMaxRedLine

Follow the steps below to complete the lab exercise:

1. Open the MyFocus job from Lab Exercise 2.

2. To verify the card is in the Field of View, click the Live Video &= button and position
the card under the camera so that it is centered in the field of view, as shown below.

NOTE: Make it as large as possible in the FOV for good resolution but leave some
room for part movement.
Exit Live Video mode.
4. Leave the first 10 spreadsheets rows (numbered 0 — 9) blank (except for A0 —
Acquirelmage).
NoTE: We will use these rows in a later lab to create an operator interface.
5. Enter the comment Find the Logo in cell B10. Be sure to start with an apostrophe

().

w

IIZI_ ‘Find the Logo
1
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In-Sight ViDi Standard Section 3 | Lab Exercise

6. Insert a TrainPatMaxRedLine tool into cell C11 of the spreadsheet.

7. Click the Pattern Region to highlight and click the Edit Graphic & button.
NoOTE: Double-clicking the Pattern Region parameter will also open the region.

Spreadsheet - Property Sheet - TrainPatMaxRedLine

Edit Insert Help

SN -1O

Image = Oimage
& Fixture

[& Pattern Region (1004,864,440,320.0,0)

8. Position the Pattern Region around the Cognex Logo as shown below and press the
<Enter> key to return to the Property Sheet.

9. Select input and result graphics for the Show parameter. Allow the defaults to
remain for all other settings.

Timeout

input and result graphics

10. Click the OK button to close the Property Sheet.
The Patterns data structure is added to the spreadsheet.

[Find the Lngjn

11. Insert a FindPatMaxRedLine tool into cell C13.
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In-Sight ViDi Standard Section 3 | Lab Exercise

12. Click the Find Region to highlight and click the Maximize Region E= button.

Spreadsheet - Property Sheet - FindPatMaxRedLine

Edit Insert Help

=S¥-H0

Image = OlImage
& Fixture (0,0,00
[l Find Region {1004,864,440,320,0,0)

13. Double click the Pattern setting to open — reference cell C11 and press the <Enter>
key.

14. Select input and result graphics for the Show parameter. Allow the defaults to
remain for all other settings.

Timeout 5000 5

Show input and result graphics

15. Click the OK button to close the Property Sheet.
A second Patterns data structure is added to the spreadsheet.

A | B B D | E | F [ 6 [ H [ T T J T K
1[|- -FlndtheLngin
11! [ OPsatterns | 1000,
12| - - [Index ¢ 53 -AngIE [Scale [Score
13 —) 0000 1275757 B46.380 .000B| 100000f 98317

NoOTE: You can customize the look of your comment notes by changing the
background and font colors.

BIETEE BR8N 4-

10| Find the Logo |
11 OPatterns 1.000
]2' [ [ lIndex ¥ Iy '.&ngle [Scale |Score

13| ' |oPatterns 0000, 1275757, 646380  -D006 100000 99317
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In-Sight ViDi Standard Section 3 | Lab Exercise

16.

17.
18.

19.
20.

Page 16

Notice the green lines through the Cognex logo

Click the Trigger Once H button to trigger your camera and move the part around,
rotate it (scroll through the images if using a database) and observe the results in the
spreadsheet.

Observe the Angle value in the spreadsheet as you rotate the card.
Update the Angle Start to -90 and Angle End to 90 and click the OK button.

Find Tolerances  {-90,90,100,100)
Angle Start
Angle End 90.000
Scale Start 100.000

Scale End 100.000

ik 4k 4 LR ik

XY Overlap 70.000

Trigger your camera and notice the changes to the Angle value in the spreadsheet.

Click the Save As =i button to save the job as MyPatterns in the folder created in
lab #1.

COGNEX



In-Sight ViDi Standard Section 3 | Lab Exercise

At the end of this lab exercise, Participants will be able to:
e Utilize logic statements to determine Pass/Fail

The Participant will utilize the following In-Sight Logic Functions to successfully complete this
exercise:

o If
e And
Logic — If

Follow the steps below to complete the lab exercise:

1. Start a new job.

2. Enter a value of -1.0 in cell A2.

3. Enter a formula into cell A4 that will display the word Accept if the value in cell A2 is
greater than zero, or display Reject if the value is less than zero.

HINT: Use the IF function under Mathematics = Logic.

A E C
0/@Image

| -1000

If(A2>0,"Accept”, 'F{Fjert"j

Lk T = s I %

4. Click the green check =2 button or press the <Enter> key to execute the formula.
5. Change the value in cell A2 to 1.0 and observe what happens.

A | E A B
0/0image 0/Oimage
1 i 1
2 -1.000 Z 1.000
3 3
le!EJEl:t ' 4 Accept
5 8
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In-Sight ViDi Standard Section 3 | Lab Exercise

Logic — If & And
Follow the steps below to complete the lab exercise:

1. Enter a value of -1.0 in cell B2.

2. Enter a formula into cell A6 that will display the word Accept in A6 if the two values
in cells A2 and B2 are both greater than zero, or display Reject if otherwise.

HINT: Use the AND function under Mathematics = Logic as the first parameter in an
IF statement.

A B C D
0/Dlimage

1

’-'l 1.000] 1.000

3

4 |Accept

If(And(AZ =007 >0)," Accept™,"Reject ]|

-l | 0| h

3. Click the green check 4 putton or press the <Enter> key to execute the formula.
4. Change the value in cell B2 to 2.0 and observe what happens.

A B C A B C
0/olmage 0/0lmage
1 1 1
2 1o00|  -1.000 — 3] rooozooq]
3 3
4 Accept 4 Accept
f Accept

5. Click the Save As button to save the job as MyCells in the folder created in lab
#1.
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In-Sight ViDi Standard Section 4 | Lab Exercise

At the end of this lab exercise, Participants will be able to:
o Ultilize the ViDiDetect tool to solve their application

The Participant will utilize the following In-Sight Vision Suite tool to successfully complete
this exercise:
e ViDiDetect Tool

Follow the steps below to complete the lab exercise:
Air Filter Inspection

1. Highlight your Emulator, click the System Settings gear and select Emulator.
USNA-2313-1064 & C @ Syster

In-Sight ViDi System System Settings

Device Discovery # |

L' isd905m_Jennifer

Emulator

In-Sight ViDi System - Emulator v

" usna-2313-1064 (This PC)

The Emulator Configuration dialog displays.

2. Select In-Sight 905M from the drop-down box and click the Configure
button.
The In-Sight Emulation Configuration dialog displays.

@] In-Sight Emulation Configuration

In-Sight ViDi PC

Set the image directory.

2048 X 1536 ChUsersymacdonaiOneDnve - Cognex Corporation\DesktophI5_ViDi Images\Vilh

0K Cancel

3. Point to the ViDiDetect_AirFilters Runtime folder and click the OK button.
NoTE: The In-Sight ViDi images can be found in the Student Folder on the desktop
of your training computer.

4. Click the Start button to start the emulator.

5. Click the Connect button to enter the Spreadsheet environment.

Start

Open HMI
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In-Sight ViDi Standard Section 4 | Lab Exercise

6. The Spreadsheet displays with the first image behind the spreadsheet. Click the

Change Split L button to bring the image next to the spreadsheet.

is Network Help

Toolbox ~ Web Pages

Properties

Cell Name
Image

Approximate Pixel Value @ (1421,1988) = 5

7. Add a ViDiDetect tool in cell B3.
NoOTE: The ViDiDetect tool is found in the Toolbox under Vision Tools 2 ViDi Tools.
The ViDiDetect Property Sheet displays.
Spreadsheet - Property Sheet - ViDiDetect
Edit Insert Help
:

General Runtime

Image

External Fixture 0

[&= Region (1004,864,440,320,0)

Show hide all

8. Double-click the Region parameter and position the region on the air filter as shown
below and press the <Enter> key.
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In-Sight ViDi Standard Section 4 | Lab Exercise

9. Drag the Show parameter into cell B6.

10.  Click the Open ViDi Editor button to enter the ViDiDetect Workspace.
The ViDiDetect Workspace displays.

Toolb.. Web.. Tags Temp.

Properties

11. Click Add to bring the images into the ViDiDetect workspace.
Display ol B

Actions for 0 Views Refresh] Add

12. Navigate to the ViDiDetect_AirFilters Training folder.
13. Select the first image and press <Ctrl + A>, this will automatically select all of the

images. Click the Open button.

Open =

« ~ 4 « ViDiDetect » ViDiDetect_AirFilters > Training v O

Organize ~ New folder

I Desktop ¢
& Downloads #
% Documents o
= Pictures

& i ) Image 00001_ ~ar Irnage 00002_ -3 Ifnage 00003 _ e Image 00004_ e Image 00006_
_ViDi Images

Lab Exercises
d Music
ViDiDetect_Vials

@ OneDrive - Cogne

= Image_00011_ ulmage 00015_ Irnage 00016_ ulmage 00017_ ulmage 00021_
% This PC et
File name: |"Image_00001_OK" ' Ir'nage 00002_OK" "Image_00003_OK" "Ima: ~ Images

Ca nCEI
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In-Sight ViDi Standard

Adding Images

Section 4 | Lab Exercise

Adding Images: Processing image

Image_00059_OK.bmp

Cancel

14. Once the images have been added, they will appear on the View Panel.

[ Spreadsheet B3.ViDiDetect X

15. Right click and select Edit ROI, allow the default External ROI to remain.

Region of Interest | External ROI = JApply Close

Image_00001_OK.pngj0:0| 5/4,2020
2123x552 (2448x2048, 1x 8-bit), Zoom 0.3x

ool Parameters G‘)

16. Click the Close button.

External ROl = Apphy] Close

Region of Interest

17. Enter ‘OK’ in the Display field and press the <Enter> key.
18. Click Actions for 127 Views and select Label Views.

Display | 'OK’

Actions for 127 Views
Label Views
Set Group
Clear Views

Accept Views

vo\.

Refresh Add

Page 22

COGNEX



In-Sight ViDi Standard Section 4 | Lab Exercise

The Label Views window displays.
Label Views %

Label the selected Views as

Good

Bad

Cancel

19. Label the selected Views as Good and click the OK button.
[@] Label Views *

Label the selected Views as

* Good

Bad

OK Cancel

The images are labeled as Good. Notice the green label in the right-hand corner.

Spreadsheet B9.ViDiDetect x

i petect KD

Database Overview ()|

Mode | Unsupervised ~ Display | 'OK

Network Model | Large Actions for 127 Views Refresh  Add

Sampling

s

a Feature Size |40
]

° Color |1
Border Type | Black
Training

Training Set 0 View

Capacity | Large
Training Passes |1
Perturbation
Rotation [[0°, 0]
Scale [0%

Aspect-Ratio [0%

20. Select Not Labeled from the Display drop-down list.

Display 'OK b o b
'"OK

Action
all
new
trained
not trained

good
bad

labeled

not labeled
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21. Click Actions for 20 Views and select Label Views.

Display = not labeled ¥ 6 b

Label Views

Set Group

Clear Views

Accept Views

The Label Views window displays.

Label Views %

Label the selected Views as

Good

Bad

Cancel

22. Label the selected Views as Bad and click the OK button.

[@] Label Views *

Label the selected Views as

Good

® Bad

| OK | Cancel

The images are labeled as Bad. Notice the red marking in the right-hand corner.
23. Train the tool by clicking the Train button.

[.Q.i input € ;’é’; Detect xgg

Unsupervised

24. Click the Yes button to select the training set.

Training Tool 'Detect’

9 Database contains no views marked for training.

Do you want to select the training set?

Yes Mo
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25. Click the Select training set from all views radio button and click the OK &
Randomize button.

Select Training Set x

(® Select training set from all views
Select training set from Image Sets

Selection 50%

OK & Randomize Cancel |

26. When Training is complete, open the Database Overview tab and review your
results. Notice that there is an area where a score is between Good and Bad and the
tool is unable to detect which is which.

Scores | ROC Count  Views «

6.52
713

Count

5.7 Score 8.0

27. Adjust the parameters for better results, do not focus on getting 100% accuracy.
While it is possible to achieve these results, we are not able to devote enough time
during our class. Ensure that you understand how to achieve these results.

28. Click the Save As button to save the job as ViDiDetect_AirFilters in the folder
created in lab #1.
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In-Sight ViDi Standard Section 4 | Lab Exercise

Textile Inspection
NOTE: Your emulator should be configured to emulate the In-Sight D902M camera

to complete this lab exercise.
1. Once you have configured your emulator new spreadsheet displays.

Spreadsheet X

B2 No contiountionwas osded. (B @ F | S WB(2C 2 no|e e BER BE | EDERN o B A S
Avial 9 BIEEIE ®80 4,
FE & 0L 52 [ W | | mage -

2. Click the Folder icon in the Filmstrip.

Filmstrip

‘m PREISEORBN KCJ U “9 '#® | Frame name: Frame

The Select the record and playback directory window displays.

2y Select the record an ayback directo
Select th d and playback directary %
- 1 ViDiDetect * ViDiDetect_Textiles > v (4]

Organize » New folder
Notebooks ~
= Pictures Runtime =
v 8 This PC Training
J 3D Objects
» [l Desktop
% Documents
¥ Downloads
b Music
&= Pictures
| videos
£9 Local Disk (C2)

Folder: | Runtime

Select Folder Cancel

3. Navigate to the ViDiDetect_Textiles Runtime folder and click the Select Folder

e ] putton.

NoOTE: The In-Sight ViDi images can be found in the Student Folder on the desktop
of your training computer.
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In-Sight ViDi Standard

The Runtime images display in the Filmstrip.

Filmstrip

SOFEHON | KKDHDY

or
e
Lo L

- i . “
PR i b. ”."‘ "‘-‘

PR EE S N P

5. Enter a ViDiDetect tool in cell B3.

00008
P

Section 4 | Lab Exercise

Toolbox Web Pages  Templates

NOTE: The ViDiDetect tool is found in the Toolbox under Vision Tools =2 ViDi Tools.

The ViDiDetect Property Sheet displays.
Spreadsheet - Property Sheet - ViDiDetect
Edit Insert Help

HE

General Runtime

mage O [Siimace

External Fixture | 0

Region (1004,864,440,320,0)

Show hide all

6. Double-click the Region parameter and position the region to include the entire ROI

as shown below and press the <Enter> key.

Page 27
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In-Sight ViDi Standard Section 4 | Lab Exercise

7. Click the Open ViDi Editor button to enter the ViDiDetect Workspace.
The ViDiDetect Workspace displays.

Actions for 0 Views Refresh  Add

T
Database Overviey

8. Click Add to bring the images into the ViDiDetect workspace.

Display w 0 v

Actions for 0 Views Refresh] Add

9. Navigate to the ViDiDetect_Textiles Training folder.
10. Select the first image and press <Ctrl + A>, this will automatically select all of the

images. Click the Open button.

Open X
- v 4 « ViDiDetect » ViDiDetect Textiles > Training ~ ()
Organize New folder = ~ [N a
Notebooks iz o
& Pictures
4% o *
L s & 5.
™ This PC " - v.Te
S s Ml 0
B 3D Objects ° . ..
I Desktop = Defect_01 = Defect_02 = Defect 03 = Defect_04 i Defect_05
| Documents
¥ Downloads ] "
J‘ g m ﬂ m H m
&= Pictures
I Videos oK 0K 02 20K 03 T 0K 04 0K 05
&9 Local Disk (C:)
v et e o asmes o R
File name: | "Defect_01" "Defect_02" "Defect_03" "Defect_04" "Defect_05" "C ~ Images v
cancel
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In-Sight ViDi Standard Section 4 | Lab Exercise

Adding Images

Adding Images: Fixturing image OK_12.bmp

Cancel

Once the images have been added, they will appear on the View Panel.

Spreadsheet B3ViDiDetect X

& pt ©

Tool Palamerers('D
Database Overview@

11. Enter ‘OK’ in the Display field and press the <Enter> key.
12. Click Actions for 30 Views and select Label Views.

Display "OK' v ﬂ .
| Actions for 30 Views Refresh Add
Label Views
Set Group

Clear Views

Accept Views

The Label Views window displays.

Label Views %

Label the selected Views as

Good

Bad

Cancel
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In-Sight ViDi Standard

Section 4 | Lab Exercise

13. Label the selected Views as Good and click the OK button.

Label Views

Label the selected Views as

® Good

Bad

[ ok

Cancel

*

The images are labeled as Good. Notice the green label in the right-hand corner.

Spreadsheet B3ViDiDetect X

Tool Parameters @

SRR (1 ained

not trained
good

15. Click Actions for 5 Views and select Label Views.

m—

O -

Display  not labeled

T Tal a1 TSN 50 3o LA TR ot

o -

Label Views

Set Group
Clear Views

Accept Views

Page 30

Display  'OK'

Actions for 30 Views Refresh  Add

©
H
:
>
[
g
o
3
3
i
8
:
o
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In-Sight ViDi Standard Section 4 | Lab Exercise

The Label Views window displays.

Label Views %

Label the selected Views as

Good

Bad

Cancel

16. Label the selected Views as Bad and click the OK button.

Label Views %

Label the selected Views as

Good

®* Bad

| OK | Cancel

The images are labeled as Bad. Notice the red marking in the right-hand corner.

Spreadsheet B3:ViDiDetect x

Unsupervised

%; Detect x@

Unsupervised
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In-Sight ViDi Standard Section 4 | Lab Exercise

18. Click the Yes button to select the training set.

Training Tool 'Detect’

'e Database contains no views marked for training.

Do you want to select the training set?

Yes I Mo |

19. Click the Select training set from all views radio button and click the OK &
Randomize button.

Select Training Set x

(@ Select training set from all views
Select training set from Image Sets

Selection | 50%

Ok randome

20. When Training is complete, open the Database Overview tab and review your
results. Notice that there is an area where a score is between Good and Bad and the
tool is unable to detect which is which.

Filter Filter
Scores | ROC Count BcHERE] 5 Scores | ROC Count | Views « | .,
100
< I I o0
™~ | | ©
o ™~
| |
| |
| |
| | £
& | | £
3 1
8 (| 3
| | e
=
| |
| |
|
I
0
54 Score 17 0 False Positives [3%] 100

21. Right-click on the image and select Edit Mask from the fly out list.

Edit ROI Ctrl+0
Edit Regions Ctrl+R
Edit Mask Ctri+M
Apply Mask To Tool Ctrl+M
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22. Change the Width to and click the Add Border button.

Mask N O # @ |wion O PI O [X] W Ty undo Apply Close

The Mask is added to the image.

Spreadsheet B3ViDiDetect X

#wao [ D OQ

/// /////////

\\\\

\\\\\

7
-

\
5\

o

N\

- F

'y
»
v
s - . .
s 8 b,
8.0
etags
LA T
v 'y
o
xS
e -
o -

/////////}/7//// //// '/'/?’/’%))‘/’/’A

23. Click Apply.
The Apply Mask dialog displays.

Apply Mask

9 Apply this mask to the tool and all Views?

[ e | ™ |

I

24. Click the Yes button to Apply this mask to the tool and all Views?
25. Click Close.

26. Open the Tool Parameters and set the following:
e Feature Size = 60
e Rotation =0, 360

27. Click the Train button.
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28. Open the Database Overview tab and review your results.
Notice there is no overlap between the good and bad results now.

35 35 35 15 (2 35 35 35 15 (;)
Images Views Labeled Trained g Images Views Labeled Trained -g
o T
@ Processing Time 315.8 + 84 msecs @ 5 @ Processing Time 315.8 + 8.4 msecs @ 5
© : @
Filter o Filter ]
[ Vi L Views « =
Scores | ROC Count | Views ~| ~ g Scores ROC Count = 8
L L m
| | S 100 Il
o
o
1 |
| | £
£ 2
. I g
= -~
S I | 3
[ | 3
i | z
|
0
4.4 Score 83 0 False Positives [%] 100
Confusion Matrix Confusion Matrix
Predicted Predicted
Good Inter Bad Total Good Inter Bad Total
Good 30 0 0 30
|Good 30 0 0 10 I
| Bad 0 0 5 5 Bad 0 0 5 5 ”

29. Click the Save As [ button to save the job as ViDiDetect_Textiles in the folder
created in lab #1.
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If Time Allows:
Show Pass/Fail Results

1. Click to Spreadsheet tab to return to the spreadsheet.

2. Double-click the ViDiDetect tool to open the Property Sheet.
3. Select result graphics with heatmap from the Show dropdown list and click the OK

button.

Spreadsheet - Property Sheet - ViDiDetect

Edit Insert Help
HE®
General Runtime
Image
External Fixture | 0
Region (0,0,1920,1200,0)

Show result graphics with heatmap ~ =5

4. Click the ViDiDetect tab and notice the heatmap markings on the image.

Bz Spreadsheet B3:.ViDiDetect x

Unsupervised

;—g Detect p@

FY
&

Tool Palamelers@

5. Click the ViDiDetect tab and notice the heatmap markings on the image.
6. Return to the Spreadsheet tab, right-click on the ViDiDetect function and select
Format -> Cells from the list.
O, cell Graphic.
Cell State...

Format B ceis
#l Row Height...
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7. Click the Graphics tab and increase the Line Width setting to 70 (or desired width).

Format Cells - Spreadsheet

Font Alignment MNumber Graphics
Font: Size:
Anal
Arial
Times New Roman
Courier New
Line Width:

&
-
3| -

8. Click the OK “ button.

The image now has a 10-pt. red border.

Cancel

Insert Comment...

Insert Getters

aphic..
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This inserts the most commonly used ViDi getter functions into the spreadsheet.

2 - Wiew [Index |Score [Lower Thre.l-Upper ThrefPassed Fegion CUUIREQIDH Inde|Scare |area

SetecloviDDetec|  opoon| | 4430|5684 780 1o00f]  oooo]  ooookERR  HERR

Notice that there is a Passed getter — we will add an IF statement to set a color based
on whether the ViDiDetect tool passed or failed.

10. In cell B6 enter the following IF statement, If(H3,0x00FF00, OxFF0000) and press
the <Enter> key.
NoTE: Cell H3 is referencing the Passed getter and 00FF00 = green, and FF0000 =
red.

-
) | If(+3,000FFO0, OxFFO000)
-

11. Insert a PlotRegion function in cell B8.
NOTE: The PlotRegion function is found under Toolbox - Image > PlotRegion.
The PlotRegion Property Sheet displays.

Spreadsheet - Property Sheet - PlotRegion

Edit Insert Help

(?7)

Image
= Region (100,100,300,300,0,0)
Name
Color [ LimeGreen ~ | = (n32CD32

Show v

12. Open the Region property and set the Width to 1750 and the Height to 1000.

Image = image
I=! Region (100,100,1750,1000,0,0)
X 100.000| 5
Y 100,000

Width 1750.000 | 5

Height 1000.000

Angle 0.000| -

Curve 0.000
13. Set the Color property to reference the If statement in cell B6 and click the OK
QK
button.
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In-Sight ViDi Standard

14. Adjust the Line Width of the PlotRegion function to 70 and click the OK “

button.

Scroll through the Filmstrip images and review the results.

15.

16. Click the Save All E button to save the job.

COGNEX

Page 38



In-Sight Vision Suite Standard Section 5 | Lab Exercise

At the end of this lab exercise, Participants will be able to:
e Utilize the ViDiCheck tool to solve their application
e Create a Layout Model to verify that all parts are present and correct

The Participant will utilize the following In-Sight Vision Suite tool to successfully complete
this exercise:
e ViDiCheck Tool
o Layout Model

Follow the steps below to complete the lab exercise:

Chocolate Assortment Inspection
NOTE: Your emulator should be configured to emulate the In-Sight D905M camera

to complete this lab exercise.

Direct the image folder to the ViDiCheck Chocolates Runtime folder.
1. Click the New Job &=l button.

A new spreadsheet displays.

P oird|aaaRNBR M| |EMERAN 0% - _iBEe AR,

Toolbox  Web Pages  Templates

Properties

2. Enter a TrainPatMaxPattern tool in cell B3.
NoTE: The TrainPatMaxRedLine tool is found in the Toolbox under Vision Tools 2
Pattern Match.

Page 39 COGNEX



In-Sight Vision Suite Standard Section 5 | Lab Exercise

The TrainPatMaxRedLine Property Sheet displays.

Spreadsheet - Property Sheet - TrainPatMaxRedLine

Edit Insert Help

Image = Olmage
& Fixture
[ Pattern Region

External Region

[ Pattern Origin

Auto Select Coarse

Auto Select Fine

Feature Threshold 20.000 | -
Train Event Train Event

Reuse Training Image

Timeout

Show hide all

Reference 1o a cell containing an Image structure. Default = $AS0.

Cancel

3. Double-click the Pattern Region parameter and position the region on the chocolate
assortment as shown below and press the <Enter> key.
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4. Click the OK button to close the TrainPatMaxRedLine Property Sheet.
The Pattern is found.

A # [ | D | E | F | G | H | I | J | K | L
0 Olmage
o pem] om
4

5. Enter a FindPatMaxRedLine tool in cell B6.
NoOTE: The FindPatMaxRedLine tool is found in the Toolbox under Vision Tools =2
Pattern Match.
The FindPatMaxRedLine Property Sheet displays.

Spreadsheet - Proper
Edit Insert Help
Image
[Z Fixture
[= Find Region
External Region
Pattern
Number to Find 1|5
Accept Threshold 50.000 | »
Ignore Polarity
Accuracy Mode High
Clutter in Score
Contrast Threshold 0.000

[ Find Tolerances  (-15,15,100,100)

XY Overlap 70.000 | 5

[& Advanced Settings (0,60)
Timeout

Show hide all

Reference to a cell containing an Image structure. Default = $AS0

Cancel
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6. Double-click the Find Region parameter and position it around the box of chocolates,
then press the <Enter> key.

The Property Sheet displays.

7. Double-click the Pattern parameter and reference the TrainPatMaxRedLine pattern
in cell B3.

Set the Find Tolerances parameters — Angle Start = -45, Angle End = 45.

8. Click the OK “ button to close the FindPatMaxRedLine Property Sheet.
The FindPatMaxRedLine Pattern is found.

4
5| | Index B¢ [y langle |Scale |Score

0 0000 1561112 1089705  -DO001 100000  97.881)

7

9. Next, enter a ViDiCheck tool in cell B9.
NOTE: The ViDiCheck tool is found in the Toolbox under Vision Tools = ViDi Tools.
The ViDiCheck Property Sheet displays.
Spreadsheet - Property Sheet - ViDiCheck
Edit Insert Help
©)

General Runtime

T Oaa—

External Fixture 0

Region (1004,864,440,320,0)

Show hide all

10. Double-click the External Fixture parameter and reference the FindPatMaxRedLine
pattern in cell B6 and press the <Enter> key.
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11. Double-click the Region parameter and position the region to include the box of
chocolates as shown below and press the <Enter> key.

bt o L T T o)

12.  Click the Open ViDi Editor button to enter the ViDiCheck Workspace.
The ViDiCheck Workspace displays.

[ Spreadsheet B9:ViDiCheck X ¥ Toolbox

E_f’; Check x@g

Toolbox Web Pages Templates

Properties

® Crested new workspace: kevab3tt

13. Click Add to bring the images into the ViDiCheck workspace.
Display v o v

Actions for 0 Views Refresh] Add
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14. Navigate to the ViDiCheck_Chocolates Training folder.

15. Select the first image and press <Ctrl + A>, this will automatically select all of the
images. Click the Open button.

Open b 4
« A « ViDiCheck > ViDiCheck_Chocolates * Training v O
Organize ~  New folder = - m @
I Desktop ¢ i i
I [ r v
¥ Downloads 3 p J&J =
5 Documents =~ W ‘ =
&= Pictures
i == Chocolate_001 w Chocolate 002 = Chocolate 003 & Chocolate 004 2 Chocolate_005
I5_ViDi Images OK oK _OK _OK

Lab Exercises
$ Music
ViDiDetect_Vials

@ OneDrive - Cogne £ Chocolate 006

= Chocolate_007

0K

= Chocolate_008

= Chocolate_009

= Chocolate 010

K K L4 L4 14
= This PC 0 o 0 0 0
e+ oumm mae soum DU BE .

File name: | "Chocolate_001_OK" "Chocolate_002_OK™ "Chocolate_003_OK™ ™ Images

Cancel

Adding Images

Adding Images: Processing image
Chocolate_034_0OK.bmp

Cancel

Once the images have been added, they will appear on the View Panel.

Spreadsheet B9:ViDiCheck X

@4 mput ©

:f'; Check x@g
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16. Click the Update Views with External Fixture button to fixture the images.

Fixturing Images

Fixturing Images: Fixturing image
Chocolate_034_OK.png

| By v |
é’} Input @ © & Check

17. Return to the Check tool.

ﬁ Input @ &; Check X@g

18. Move the Feature Size box over the first chocolate. Drag the red circle to the desired
size (approximately the same size as the chocolate) and move it to be centered over
the first chocolate.

NOTE: The Feature Size box is found in the lower left-hand side of the Workspace.

[

19. Click on the image outside of your feature size box.

A green rectangle the same size as your feature size box displays.
20. Move the box over the first chocolate and click the 0 to open the text box. Label this
chocolate Chocolate 0 and press the <Enter> key.
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21. Click on the remaining chocolates in the box to label.

NOTE: As you click on each chocolate the labeled box will display — make sure that
each one is centered over the corresponding chocolate.

22. Label at least three images with the names of each chocolate.

23. Move onto the next chocolate assortments in your image database and label at least
five assortments with the names of each chocolate as shown below.
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24. Select the Training Set by clicking the Training Set parameter.

Training
Training Set Q Views

Epoch Count |50

The Select Training Set dialog displays.
Select Training Set d

#®) Select training set from all views
Select training set from Image Sets

Selection 50%

OK & Randomize ' Cancel

25. Select training set from all views and click the OK & Randomize
button.

26. Click the Train button to train.

| ok & Randomize |

-
4 Input @ &
[External

27. Once the training is complete scroll through your images to view the results.
Notice on the images in addition to the green labels there are also yellow markings
recognizing the different chocolates.

28. Confirm that all chocolates are marked correctly and label any chocolates that are
not marked. Right-click and Accept View for the views that are marked in yellow,
(make any necessary corrections).

Accept View Ctrl+Shift+A

Clear Marking
Clear Marking & Labels
Process

Sets

Rename Image

Remove Image

Edit ROI
Edit Mask
Apply Mask To Tool

Export View

Display

V] Show Overlay
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In-Sight ViDi may mark a feature in orange — this means that there is a mismatch

29. |If there is a mismatch, or ViDi has marked a chocolate incorrectly, right-click on the
image select Accept View, (make any necessary corrections) right-click and select
Add to training set.

Accept View Ctrl+Shift+A
Clear Marking

Clear Marking & Labels

Process Cirl+P

Sets »

Rename Image

Remove Image

| Add to training set

31. Review your results.

Feature Found Train Labeled Recall Precision F-Score

: ¢ Chocolate 0 241 82 110 100.0 1000 1000
Confusion Matrix | | e 1 a0 5o 64 1000 1000 1000
Chocolate_2 70 46 58 1000 100.0 100.0

Chocolate_3 215 103 113 1000 100.0 100.0

Flipped_1 7 4 & 1000 1000  100.0

Flipped_2 21 1 13 1000 100.0 100.0

644 296 364 1000 100.0 100.0

@ (6 classes) 100.0 100.0 100.0
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Build the Models for the Chocolate Assortments

Follow the steps below to complete the lab exercise:
1. Select the first assortment with four different chocolates and then select Edit Models
from the Tool menu.

Tool Image Database Tool View

Edit Deployment Target

Tra

Reset

Rename

Clone

Export

Edit Models

The Model Editor displays.

[@] Madel Editor - dxaguggs.2to/default/Check - m] >

@ © | Move Back | Previous View Next View . Model 1 (Layout) - O@FE

Enable |
View Filter

Add

2. Click the pencil EI icon to rename the model Assortment 0 and press the <Enter>
key.

3. Click the Add button.

- O X
Assortment_0 oo # =
Enable ]
View Filter
[ Add
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4. Move the ROI to outline the first chocolate. Rename the Region to Chocolate 2 and
check the Chocolate2 checkbox.

Model Editor - dxaqugg3.2te/default/Check - O x
°° Move Back Previous View Next View - Assortment_0 b oe,‘ E
Enable V|
o
Chocolate_2
I Temove | Rename
Region
Units Mode Percent >
Extent X [9.277%, 46.828%]
Extent ¥ [10.675%, 49.209%]

Feature Matching

| Chocolated

-

I iv| Chocolate2
1 HGEM
1 Flipped1
] Flipped2

Feature Count |1

5. Repeat for the remaining 3 chocolates.
Chocolate 1

[@] Madel Editor - dxaguggs.2to/default/Check - m] >
© @ | Move Back Previous View Next View - | Assortment 0 - O@FE

Enable \f

View Filter

Chocolate_1

Region

Units Mode Percent v
Extent X [53.115%, 89.575%]

Extent ¥ [9.722%, 51.306%]

Feature Matching

I /| Chocolate1

TrRGCoate

] Chocolate3
] Flipped1
[] Flipped2

Feature Count |1
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Chocolate 3

[@] Madel Editor - dxaguggs.2to/default/Check - m] >
© © | Move Back | Previous View Next View - | Assortment 0 T

Enable \f

View Filter

Chocolate_2

| Chocolate_3

Region

Units Mode Percent e

Extent X [9.641%, 46.828%]

Extent Y [53.185%, 93.435%]

Feature Matching

[C] Chocolated
] Chocolatel

P2 W

/] Chocolate3
Iw; "

] Flipped2

Feature Count |1

[@] Madel Editor - dxaquggs.2to/default/Check — m] %
oa Move Back = Previous View Next View - | Assortment_0 & ee.‘ =
Enable v

View Filter

Chocolate_2
Chocolate_1

Chocolate 0

Region
Units Mode Percent v
Extent X [53.297%, 89.575%]

Extent ¥ [54.328%, 96.103%]

P

-l - - -

Feature Matching

I /] Checolated
p—— ey
[] Chocolate2

o - - -

| Chocolate3
[] Flipped?
] Flipped2

Feature Count |!

7. Review the Results.
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When the chocolates are all in the proper slots the results will display 4/4.
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When one of the chocolates is in the proper slot the results will display 1/4.

8. Click the Save As button to save the job as ViDiCheck_Chocolates in the folder
created in lab #1.
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Spark Plug Inspection

1. Click the New Job &=l button.
A new spreadsheet displays.

) in-sight visi

File Edit

Filmstrip

LA

© successtu depioyment

2. Click the Folder icon in the Filmstrip.

Filmstrip

g e : -]

Section 5 | Lab Exercise

Toolbox

Toolbox Web Pages Templates

Properties

Cell Name.

Image

Frame name: Frame

The Select the record and playback directory window displays.

Select the record and playback directory

— v 4 « ViDiCheck > ViDiCheck _SparkPlugs >
Organize = MNew folder
Notebooks ~  Name
&= Pictures Aintime
= This PC Training

¥ 3D Objects
I Deskiop

~*| Documents
¥ Downloads
D Music

& Pictures
I videos
&9 Local Disk (C)

Folder: | Runtime

Qn

4/1/2020 12:02 PM File folder

Select Folder Cancel
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3. Navigate to the ViDiCheck_SparkPlugs Runtime folder and click the Select Folder

e

NoTE: The In-Sight ViDi images can be found in the Student Folder on the desktop
of your training computer.

The Runtime images display in the Filmstrip.

Filmstrip
m g HFOR KKEDN @ |8 | Frome name: Frame
Image Mixed (10) Mixed (12) Mixed (14) Mixed (15) Mixed (17) Mixed (19) Mixed (2) Mixed (21) Mixed (6) Mixed (7) Mixed (8)

@ e QEeCR
© & 0 = » DE - o & . D e @7 e A

eosn || @686

Spreadsheet x
;="

5. Enter a ViDiCheck tool into cell B3.
The ViDiCheck Property Sheet displays.
Spreadsheet - Property Sheet - ViDiCheck

Edit Insert Help

a8

General Runtime

External Fixture 0

Region (1004,864,440,320,0)

Show hide all

6. Position the region to include all of the sparkplugs and click the Open ViDi Editor

Sl B button to enter the ViDiCheck Workspace.
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The ViDiCheck Workspace displays.

Spreadsheet B3:ViDiCheck X Toolbox

o © @ check KPS

Tool Parameters (V)|
Database Overview (3|

Toolbox ~ Web Pages  Templates

Properties v

Filmstrip
=0 FRO M| 11 DD % @[5 Framename: rame v
Mixed (10) Mixed (12) Mixed (14) Mixed (15) Mixed (17) Mixed (19) Mixed (2) Mixed (21) Mixed (6) Mixed (7) Mixed (8) Mixed (9) OKBlack (2)  OKBlack (3)  OKBlack (4)

® X3

(® Created new workspace: nncyOw50.mS;

7. Click Add to bring the images into the ViDiCheck workspace.
Display v o v

Actions for 0 Views Refresh] Add

8. Navigate to the ViDiCheck_SparkPlugs Training folder.

9. Select the first image and press <Ctrl + A>, this will automatically select all of the
images. Click the Open button.

Open X
« v 4 « ViDiCheck » ViDiCheck_SparkPlugs > Training v (9]

Organize New folder = ~ [ 0

Lab Exercises %

Presentations

@ OneDrive - Cogne
Attachments
Il Desktop
| Documents
Notebooks

= Pictures

| This PC
J 3D Objects
I Desktop i @@ -

= Image_00051

File name: | "Image_00042" "Image_00046" "Image_00048" “Image_00049" " -~ Images v

Cancel
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10.

Once the images have been added, they will appear on the View Panel. Click an

image to select.

Spreadsheet B3:ViDiCheck X

11.

12.
13.

14.

Page 57

0
g_ﬁ lnput@° Y Check

Click the Update Views with External Fixture button to fixture the images.

Fixturing Images

Fixturing Images: Fotturing image NGSilver (2).png

Cancel

| ¥ g |
é Input @ © H check

Right-click on the image and select Edit ROI to define the Region of Interest.
Allow the default of External ROI to remain and click Close.

Region of Interest | External ROI =] Apply]Close

Open the Tool Parameters and set the following:
e Feature Size = 460

Detail = 4

Epoch Count = 150

Rotation = -180, 180

Luminance = 5%

Contrast = 5%

Sampling Density = 3

COGNEX
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15. Click on the image and center the green Feature Size box over the first sparkplug,
as shown below.

16. Click the 0 to open the text box. Label this sparkplug Silver and press the <Enter>

key.

17. Label the remaining sparkplugs in the image.

Image_00042.png|0:0| 4/1/2020
440x320 (2448x2048, 1x 8-bit), Zoom 0.3x

18. Label at least 75 of each sparkplug. Open the Database Overview to confirm the

number of each sparkplug

labeled.

Feature

Black
Silver

Found Train Labe

0
0
0 0
@ (2 classes)

led Recall Precision F-Score
81
75
156 0.0
0.0

19. Select the Training Set by clicking the Training Set parameter.

Training

Training Set Q Views

Epoch Count |50
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20.

21.

22.

23.

Page 59

The Select Training Set dialog displays.
Select Training Set d

#®) Select training set from all views
Select training set from Image Sets

Selection 50%

| OK & Randomize | Cancel

Select training set from all views and click the OK & Randomize | oK & Randomize |

button.
Click the Train button to train.

% ot © @ Check X@g

[External

Once the training is complete scroll through your images to view the results.

Notice on the images in addition to the green labels there are also yellow markings
recognizing the different sparkplugs.

Confirm that all sparkplugs are marked correctly and label any sparkplugs that are
not marked. Right-click and Accept View for the views that are marked in yellow and
are correct.

Clear Marking & Labels
Process

Sets

Rename Image

Remove Image

Edit ROI
Edit Mask

Apply Mask To Tool

Export View
Display

Show Overlay
Cycle through Qverlays
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24. The marking will change from yellow to green, right-click and select Add to training
set.

Review the remaining images.

Accept View

Clear Marking

Clear Marking & Labels
Process

Sets

Rename Image

Add to training set

Edit ROI

Edit Mask

Apply Mask To Tool
Export View

Display

Show Overlay

26. Review your results.

Feature Found Train Labeled Recall Precision F-5core
Black 205 115 205 100.0 100.0 100.0

Silver 221 13 221 100.0 100.0 100.0
426 228 426 100.0 100.0 100.0
@ (2 classes) 100.0 100.0 100.0

Model Found Train Labeled Recall Precision F-Score
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Build the Layout Model for the Sparkplugs

1. Find a sparkplug assortment that has a black sparkplug in each spot and then select
Edit Models from the Tool menu.

Tool Image Database Tool View

Edit Deployment Target

Train

Process

Reset

Rename

Clone

Export

Edit Models

The Model Editor displays.

Madel Editor - mOwapqei.unz/default/Check - O X
@ @ | Move Back  Previous View Next View . Model 1 (Layout) -O@F=E
Enable L4
8x2048, 1x 8-bit),

View Filter

Add

2. Click the pencil EI icon to rename the model Black SparkPlugs and press the
<Enter> key.

3. Click the Add button.

= O X
Black_SparkPlugs i e’e .ﬁ E
Enable v
View Filter
| Add
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4. Move the ROI to outline the first sparkplug. Rename the Region to Black and check
the Black checkbox.

Madel Editor - mOwapqei.unz/default/Check - O x
© @ | Move Back | Previous View Next View . | Black_SparkPlugs - O@FE
Enable Ld
L i
Black
T Remove name
Region

Units Mode Percent
Extent X [9.277%, 26.819%]
Extent Y [0.652%, 21.304%]

Feature Matching

I | Black

Tonver

Feature Count |1

[@ Model Editor - mOwapqei.unz/default/Check - m] >
© @ | Move Back Previous View Next View - | Black_SparkPlugs - O@FE

Enable o
View Filter
Black
Black
Black
Black
Black
Black
Black
Black
Black
Black
Black
Black
Black
Black
Black
Black

| add | [ Remove | | Rename | | 1
Region
Units Mode Percent

Extent X [70.941%, 91.576%]

6. Close the Model Editor and process the model.

9 mput @ 45 Check Q@g
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7. Review the Results.
When there are black sparkplugs in every spot the results will display 16/16.

8. Click the Save As I button to save the job as ViDiCheck_SparkPlugs in the folder
created in lab #1.

Page 63 COGNEX



In-Sight Vision Suite Standard Section 5 | Lab Exercise

If Time Allows:

1. Create a Layout Model named Silver_SparkPlugs for the sparkplug assortment that
has a silver sparkplug in each spot.

2. Click the Save All Il putton to save the job.
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At the end of this lab exercise, Participants will be able to:
e Utilize the ViDiRead tool to solve their OCR application

The Participant will utilize the following In-Sight Vision Suite tool to successfully complete
this exercise:
e ViDiRead Tool

Date Code OCR
NOTE: Your emulator should be configured to emulate the In-Sight D905M camera

to complete this lab exercise.
Point to ViDiRead_DateCodeOCR Runtime image folder. You will be prompted to

Restart your Emulator.
1. The Spreadsheet displays with the first image behind the spreadsheet. Click the

Change Split button to bring the image next to the spreadsheet.

S i d|aaaBMR BT |6 M[ERN o

20 CTE4s
HER 128215358

2. Enter a TrainPatMaxRedLine tool in cell B3.
NOTE: The TrainPatMaxRedLine tool is found in the Toolbox under Vision Tools =
Pattern Match.
The TrainPatMaxRedLine Property Sheet displays.

Spreadsheet - Property Sheet - TrainPatMaxRedLine = O X
Edit Insert Help

@

I Fixture o

Pattern Region (1004,864,440,320,0,0)

External Region 1]
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3. Double-click the Pattern Region parameter and position the region around the bottle
cap as shown below and press the <Enter> key.

4. Click the OK “ button to close the TrainPatMaxRedLine Property Sheet.
The Pattern is found.

A LI C | D | E | = | G | H | | J | K. | L

1] 'Dlmege
i A

5. Enter a FindPatMaxRedLine tool in cell B6.
NoTE: The FindPatMaxRedLine tool is found in the Toolbox under Vision Tools 2
Pattern Match.
The FindPatMaxRedLine Property Sheet displays.
Spreadsheet - Property Sheet - FindPatMaxRedLine = O x
Edit Insert Help
13| O

[= Fixture {0,0,0)

Find Region (1004,864,440,320,0.0)

External Region 0
Pattern 0

Mumber to Find

6. Double-click the Find Region parameter and click the Maximize Cell Region
button to utilize the entire Region of Interest and press the <Enter> key.
7. Double-click the Pattern parameter and reference the TrainPatMaxRedLine pattern

in cell B3.
8. Click the OK “ button to close the FindPatMaxRedLine Property Sheet.
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The FindPatMaxRedLine Pattern is found.

1.000

, Angle Scale :
0000 1274183 574652 0018 100000[ 98254

R 12 =0 CTE4S
HaR L iHos1a88

9. Enter a Fixture tool in cell B9.
NOTE: Type Fixture( in the cell and the tool will display.

10. Open the Fixture parameter, click the Insert Relative Reference button and
reference cells D6, E6 and F6, press the <Enter> key.

4

5 Index X f Angle Scale Score

B oPatterns DDDD[ 1274193 574 652 DDIEI 100.000 98254
2 A i Angle

g OF r<dure 0.000 0.000 0.000

10

11. Click the OK [ o | button to close the Fixture tool.
Notice the red crosshairs on the bottle cap.

12. Enter a ViDiRead tool in cell B12.

13. Double-click the External Fixture parameter and reference the Fixture tool in cell
B9.

Page 67 COGNEX



In-Sight Vision Suite Standard Section 6 | Lab Exercise

14. Double-click the Region parameter and position it as shown below and press the
<Enter> key.

20 cIs543
MAR 125321358 T

L™

15.  Click the Open ViDi Editor IR putton.
The ViDiRead Workspace opens.
16. From the toolbar select Tool - Edit Models.
Tool Image Database Tool View
Edit Deployment Target

Train

Process

Reset

Rename

Export

Edit Models

17. The Model Editor dialog displays. Click the Minus @ button to remove the current
model.

O *
Maodel 1 (String) e E

Enable b

Threshold 50%

View Filter

Occurrences 1 (L
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18.  Click the OK button to remove model from the tool and close the Model
Editor dialog.

19. Click Add to bring the images into the workspace.

20. Navigate to the ViDiRead_DateCodeOCR Training folder.

21. Select the first image and press <Ctrl + A>, this will automatically select all of the
images. Click the Open button.

Open X
v 4 « ViDiRead > ViDiRead_DateCodeOCR *> Training v [&]
Organize New folder = - i | o
Lab Exercises ™ i
Skills Journals
@ OneDrive - Cogne i
Attachments
B Desktop = DateCode_000 = DateCode 000 = DateCode 000 = DateCode 000 < DateCode 000
00K 1.0K 20K 3.0K 4 0K
= Documents
Notebooks
& Pictures - !_
® This PC F £ K
B 3D Objects i DateCode 000 < DateCode 000 & DateCode 000 = DateCode 000 < DateCode_000
50K 6_0K TOK 8_0K 90K
Il Desktop - - - & - o
File name: |"DateCode_0000_OK" "DateCode_0001_OK" "DateCode_0002_O Images b
cancel

The images display.
Notice that the ViDiRead tool has identified some of the characters and marked them
in yellow.

Database Overview (3)

20, 4128
i :ai?»"“‘“’a‘”i

22. Inthe Tool Parameters set the following:

e Epoch Count = 100
23. Move the Feature Size box over the first character. Drag the red circle to the desired
size (approximately the same size as the character).

24. Click on the image outside of your feature size box.
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A green rectangle the same size as your feature size box displays.

25. Move the box to the first letter, click the ? to open the text box. Label this character
M and press the <Enter> key.

26. Scroll out to confirm that all characters are visible and add the labels to the remaining
characters.

27. Repeat for more bottles.
28. From the toolbar select Tool > Edit Models.
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29.

30.

31.

32.

33.
34.

35.

36.

Page 71

The Model Editor dialog displays. Click the Plus button to add a Regex Model.

— O *
o=

Node Model
Regex Model
String Model

NOTE: There are two lines on each bottle, so we will enter 2 Regex Models.

Line 1 is the date code, enter \u{3} \d{2} \d{2} \u{2}\d{3} in the Regex Properties
Regex field and uncheck the Angle checkbox.

NOTE: \u = upper case letter and \d = digit.

Regex Properties
Regex \u(3} \d{2} \di{2) \u2)\d(3)

Click the Plus sign to enter a new Regex Model.

— 7 e
Model 1 (Regex) v@ '# = R
Enable [v] Node Model
I Regex Model
Threshold | 50%
String Model

Enter \d{4}\u{2}\d{6} in the Regex Properties Regex field and uncheck the Angle
checkbox.

Regex Properties

Regex \di4hui2)\d{6}

Click the X in the upper-right hand corner to close the Model Editor dialog.
Click the Book to process the models.

Confirm the models are found and click the Train (brain) button.

Click the Yes button to select your training set.
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37. Click the OK & Randomize L2¢&Rneemze | b o 0 select the training set.

Select Training Set i

#®) Select training set from all views
Select training set from Image Sets

Selection 50%

OK & Randomize Cancel

38. Once the training is complete scroll through the images to view your results.

39. Adjust the parameters for better results, do not focus on getting 100% accuracy.
While it is possible to achieve these results, we are not able to devote enough time
during our class.

40. Click the Save As button to save the job as ViDiRead_DateCodeOCR in the
folder created in lab #1.
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Spice Bottles OCR

Follow the steps below to complete the lab exercise:

1.

Page 73

Highlight your Emulator, click the System Settings gear and select Emulator.

USNA-2313-1064

In-Sight ViDi System

L' isd905m_Jennifer

Emulator

In-Sight ViDi System - Emulator v

" usna-2313-1064 (This PC)

The Emulator Configuration dialog displays.

Select In-Sight ViDi PC from the drop-down box and click the Configure
button.

The In-Sight Emulation Configuration dialog displays.

@] In-Sight Emulation Configuration
In-Sight ViDi PC
Set the image directory.

2048 X 1536 ChUsersymacdonaiOneDnve - Cognex Corporation\DesktophI5_ViDi Images\Vilh

0K Cancel

Point to the ViDiRead_SpiceBottlesOCR Runtime folder and click the OK
button.

Click the Start button to start the emulator.

NoOTE: If the emulator is already running the In-Sight ViDi PC the start button will have
a Stop button in its place. Click the X in the upper-right hand corner to close the
Emulator Configuration dialog.

Click the Connect button to enter the Spreadsheet environment.

Start

Open HMI

COGNEX
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6. The Spreadsheet displays with the first image behind the spreadsheet. Click the
Change Split =l button to bring the image next to the spreadsheet.

Spreadsheet X

B2 No configuration was loaded. _ W)

7. Notice that the date stamp is upside down on the spice bottle cap. From the toolbar
select Image - Orientation > Rotate 180.
Image Job Tools Metwork Help
Zoom
Orientation
M|  Show Saturation Ctri+Shift+8 [ﬁl Rotate Clockwise 90
2% Rotate 180

= iy = | [&] Rotate Clockwise 270

Add a ViDiRead tool to cell B3.

Open ViDi Editor

Maximize the region and click the Open ViDi Editor button.

The ViDiRead Workspace opens.

Page 74 COGNEX



In-Sight Vision Suite Standard

Section 6 | Lab Exercise

10. Click Add to bring the images into the workspace.

Display Y o v
Actions for 0 Views Refresh

11. Navigate to the ViDiRead_SpiceBottlesOCR Training folder.

12. Select the first image and press <Ctrl + A>, this will automatically select all of the
images. Click the Open button.

Open

T « ViDiRead > ViDiRead_SpiceBottlesOCR * Training

Organize ~ New folder

Lab Exercises

~ ~
Presentations
L
@ OneDrive - Cogne

e £Spices 001_0K 2 Spices 002.0K £ Spices 003 OK 2 Spices 004 OK 2 Spices_005_OK
Il Desktop

~+| Documents ( "
Notebooks 3
& Pictures

> Spices 006 OK = Spices 007 OK ' Spices 008 OK == Spices_009_OK

File name: | "Spices_001_OK" "Spices_002_OK" "Spices_003_OK" "Spices_004,

< Spices_010_0OK
® This PC
B 3D Objects

Il Desktop

v Images v

Cancel

Adding Images

Adding Images: Processing image
Spices_037_OK.bmp

Cancel

13. Scroll out so that the complete image is in the view.
14. Right-click and select Edit ROI from the list.

Create Model

Edit ROI Ctri«0

Edit Mask Ctrl=M
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15. Change the ROI to Internal and set the following parameters:
e Offset =-100%, -100%
o Size = 100%x100%
e Rotation = 180%
Click Apply and Close.

Region of Interest = Percent = "_ -100%, -100% ]j 100%x100% | == ‘IE#J‘ Bﬂ 11 Internal = Apply

The ViDiRead tool will process on the GPU.

ri processing on GPU
L‘é‘u Input 0 Read 56% done, 48 Seconds remaining X

16. In the Tool Parameters set the following:
e Feature Size = 70x130
e Angle Range = -45,45
17. From the toolbar select Tool > Edit Models.

Tool Image Database Tool View
Edit Deployment Target

Train

Process

Reset

Rename

Export

Edit Models

18.  The Model Editor dialog displays. Click the Minus @ button to remove the current
model.

- O X
Model 1 (String) v @ =

Enable |

Threshold 50%

View Filter

Occurrences 1 []an
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19.  Click the OK button to remove model from the tool.

Remove Model d

Remove model "Model 1 (String)’ from tool?

[ ok || cancel

20. Click on the first letter of the string to add the green Feature Size box, click the ? to
open the text box. Label this letter B and press the <Enter> key.

21. Click on the remaining characters to add the labels.

22. Repeat for more bottle caps.

NOTE: There should be a minimum of 5 of each character labeled. Open the Database
Overview tab to see the count.

23. From the toolbar select Tool = Edit Models.

Tool Image Database Tool View
Edit Deployment Target
Train

Process

Reset

Rename

Export

Edit Models
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24. The Model Editor dialog displays. Click the Plus &l button to add a Regex Model.

— O *
o=

Node Model
Regex Model
String Model

NOTE: There are three lines on each bottle cap, so we will enter 3 Regex Models.
25. Line 1 always has BEST BY so enter that into the Regex Properties Regex field.

Regex Properties

Regex BEST BY

26. Click the Plus ™ sign to enter a new Regex Model.

— J'.r
Model 1 (Regex) VEb P 5"’
Enable [+] Node Model
| Regex Model
Threshold  |50%
String Model

27. Line 2 is the date code. Enter \u\u\u \d\d \d\d \u in the Regex Properties Regex field.
NOTE: \u = upper case letter and \d = digit.

Regex Properties

Regex Ywihuhu \d\d \divd '~,|.l

28. Click the Plus sign to enter a new Regex Model.

- gl
Model 2 (Regex) vlgp S E 5‘
Enable i Node Model
I Regex Model I
Threshold |50%
String Model

29. Line 3 is the time code. Enter \d\d:\d\d in the Regex Properties Regex field.

Regex Properties

Regex \ddiid\d

30. Click the X in the upper-right hand corner to close the Model Editor dialog.
31. Click the Book to process the models.

Page 78 COGNEX



In-Sight Vision Suite Standard Section 6 | Lab Exercise

32. Confirm the models are found and click the Train (brain) button.

33. Click the Yes button to select your training set.

Training Tool 'Read’

e Database contains no views marked for training.

Do you want to select the training set?

]~

34. Click the OK & Randomize L2¢&Rncemze | b o 10 select the training set.

Select Training Set x

®) Select training set from all views
Select training set from Image Sets

Selection 50%

[ oK & Randomize || cancel

36. Once the training is complete scroll through the images to view your results.

37. Adjust the parameters for better results, do not focus on getting 100% accuracy.
While it is possible to achieve these results, we are not able to devote enough time
during our class.
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38. Click the Save As button to save the job as ViDiRead_SpiceBottles in the folder
created in lab #1.
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At the end of this lab exercise, Participants will be able to:
e Use the TCPClient to define a spreadsheet cell as a TCP/IP client, initiating the

communication with another TCP/IP device for sharing data over the network

The Participant will utilize the following In-Sight Vision Suite tools to successfully complete
this exercise:

e TCPClient

e Format String

e HyperTerminal

Follow the steps below to complete the lab exercise:

1. Open a new job and capture an image of the Cognex business card.

2. Enter a TrainPatMaxRedLine tool in cell B3, set the Pattern Region to find the
Cognex Logo.

The Pattern is found.

o [

3. Enter a FindPatMaxRedLine tool in cell B6, set the FindRegion to the entire Region
of Interest, and set the Pattern to reference cell B3.

The PatMaxRedLine pattern is found.

|oPatterns | E.DDG.

Index B Y Angle Scale |Scare
D.0DD| 1488792  304.706 0.009 100.000 97.776

=& n | &K

4. Enter a TCPClient function in cell B9.

NoTE: The TCPClient function is found in the Toolbox under Input/Output - Network
- TCPClient.

The TCPClient Property Sheet displays.

Spreadsheet - Property Sheet - TCPClient
Edit Insert Help

BB s (1)

Host Name

Port Number
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5. Enter your computer’s /P Address in the Host Name field and 3000 in the Port
Number field.

6. Click the OK button.

The TCPClient information is entered into the spreadsheet.

ert& Test string

7. Enter a FormatString function in cell B12.

The FormatString Property Sheet displays.
8. Enter the following information in Starting/Ending section of the Property Sheet:
e Leading Text = ‘ (single quote)
e Trailing Text = ‘ (single quote)
e Terminators = Carriage Return (CR)
e Use Delimiter = check the checkbox

Spreadsheet - Property Sheet - Format5tring

Starting/Ending » Use Delimiter
Leading Text: * ® Standard: Comma
Trailing Text:  ° Other:

Terminators:  Carniage Return (CR) v

9. Click the Add button to enter the following information in the Arguments section of
the Property Sheet:

e Line 1 = Check the Include Label checkbox, enter X (space) in the Label
field, reference the X parameter in the FindPatMaxRedLine tool, 2 decimal
places

e Line 2 = Check the Include Label checkbox, enter Y (space) in Label field,
reference the Y parameter in the FindPatMaxRedLine tool, 2 decimal places

¢ Line 3 = Check the Include Label checkbox, enter Angle (space) in the Label
field, reference the Angle parameter in the FindPatMaxRedLine tool, 2
decimal places

Arguments

_ . Add
Include Label Data Type Decimal Fixed Field Padding

Label Places Width Width
Delete

Floating Point 2|~
L,Ir_:

Floating Point 2| -

Floating Point 2l = 8 : || Leading Spaces

10. Click the OK button.

11. Open the WriteDevice function in cell C9, change the formula to reference the
FormatString function in cell B12 (writeDevice($A$0,89,512)).
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12. Click the Online button to Online.
File

Bl ™E < . @Verify [ Online _

Setting up HyperTerminal

Edit View Insert Format Image Job Tools MNetwork Help

Spreadsheet X Main

13. Start HyperTerminal.
14. The HyperTerminal warning displays. Click the No button to continue.

HyperTerminal

You may need to install a modem before you can make a
connection.
‘Would you like to do this now?

The Connection

Description dialog displays.

Enter a name and choose an icon for the connection:

Name:

lcon:

Cacs

15. Name the new Connection TCPIP and click the OK button.

The Connect To

Page 83

dialog displays.

Connect To ? X

TCPIP

Enter details for the host that you want to call:

Host address: ||

Port number: [23

Connect using: | TCP/IP (Winsock) w

==

Section 7 | Lab Exercise

COGNEX
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16. Enter the /P Address of your camera in the Host address field and enter 3000 in the
Port number field.
NOTE: The port number must be the same as the port number that was entered in the
TCPClient function.

17. Connect using: TCP/IP (Winsock) and click the OK button.
18. Click the OK button to continue.
19. The HyperTerminal warning dialog displays. Click the OK button to continue.

HyperTerminal s

o Unable to connect to 192.168.0.12 port 3000

20. From the Call menu in the Toolbar select Wait for a Call.

B TCPIP - HyperTerminal - O x
File Edit View Transfer Help

O & Call
Wait for a Call

Stop Waiting

Disconnect

21. The HyperTerminal warning dialog displays. Click the No button to continue.

HyperTerminal

You may need to install a modem before you can make a
connection.
Would you like to do this now?

The results display in HyperTerminal.

"R 1637.83,Y 231.53,Angle -4.15°
'R 1714 .47,V 237.41 ,Angle -4.99°
'R 1765.36,Y 272.31 ,Angle -5.91°
'K 1810.93,Y 339.84 Angle -6.40°
'R 1823.73.Y 432.21 ,Angle -6.10°
'K 1813.80.Y 507.11,Angle -5.58°
"R 1791.40,Y 540.42 Angle -5.21°
"R 1768.55,Y 557.32 ,Angle -4.51°
'K 1750.95.Y 535.11 .Angle -4.88"
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22. Move the business card in the FOV, review your results and click the Offline button
to go Offline.

File View Job Tools MNetwork Help

0 Offline _

Spreadsheet Web HMI  x

23. Save your job as TCPClient in the In-Sight Vision Suite folder created in Lab #1.
24. Close HyperTerminal and click the Yes button save the TCPIP connection

HyperTerminal Pt

|  Doyouwant to save the connection named "TCPIP"?

Yes No Cancel
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At the end of this lab exercise, Participants will be able to:
Create a custom interface accessible from other devices, including status indicators,
inspection results and interactive controls to view and affect the vision application

The Participant will utilize the following In-Sight Vision Suite tool to successfully complete
this exercise:

Tags

WebPages

User Inputs

Follow the steps below to complete the lab exercise:
ViDiCheck_Chocolates HMI

NOTE: /n order for the chocolate images to display in the HMI your emulator should
be configured to emulate the In-Sight D905M camera and directed to the
ViDiCheck Chocolates Runtime folder.

1. Open the ViDiCheck_Chocolates job from lab exercise #5.
The ViDiCheck_Chocolates job displays.

A 8 c 3] & F G H i K L M N o

0[Dimage
1
2
3 DPatems

g =

i
i

2. Highlight cell H6 (the PatMax RedLine score), right-click and select Publish from the

fly-out list.
5 Index b Y Angle Scale Score
B oFatterns 0.000, 1564.519) 1096847 2867
7
8
g oVIDICheck @ Paste
:? Create a WebPage from Selected Cells
12 Publish
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A new Tag named Score displays in the Properties panel.

Properties

Cell Name
Image

Score

Section 8 | Lab Exercise

3. Open the ViDiCheck tool and drag the Show parameter into cell B13. Close the

ViDiCheck tool.
The Show parameter displays.
12
]3- [Shaw
14| hide all
15| _ 0.000
16

& Main Spreadsheet X

BE No configuration was loaded. _ W & 8 | ob Wl 2

1 MEDLI w | = ListBox("hide all*,"result graphics only”

A

. input graphics only”,"input and result graphics®)

I |

Cc

Properties

Cell Name

Image

Score

Menu

Page 88

0|olmage

-

a

al [oPatems | 1.000|

- | | |

5| Indes B ¥

B| |pPatens | pooo| 1179.248) 997 669
L [ | | |

H

gl |DviDiCheck
= [ :

1]
12|
13| [Show
j] Jrice ai A
15 0.000
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5. Add a GetAllTime function in cell B1 and reference cell A0 type JobTime in the
textbox of the Edit Toolbar.

k2 Spreadsheet X

= | 32 | = HE No configuration was loaded. - RamE aWma @ o :
gpwae | | A o VIBIEEE 886 A,

1 GetAllTime(A0) ._ : o

7| | 5 B & L foc ([l W | [ME R | JobTime » = GetAllTime(" )

Properties

Cell Name
Image
Score
Menu

JobTime

6. Double-click the Main WebPage in the Address panel to open.
The Main WebPage opens in a new tab.

B Spreadsheet

7. Open the Tags menu by clicking the Tags tab.

Toolbox Web Pages Tags Templates

Properties

8. Drag the three new tags onto the Main WebPage.
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NOTE: The new tags are found under the Tasks = Spreadsheet section of the Tags
menu.

Tags

B3] & Filter By Name:

Type

1J InspectionTask
I®8 ExecutionTime
[® HasError
I8l |InspectionResult

Double
Integer
b BB Score Double
@ Timeout Int64
@ TriggerEnabled Boolean
b {0 WebPages

NOTE:

Score 89.810

Menu

JobTime

9. Navigate to the Spreadsheet tab.

Spreadsheet x W ET)
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10. Right-click on the ViDiCheck tool and select Insert Getters from the fly-out list.

Edit Function...

Insert Comment...

Insert Getters

The Getters for the ViDiCheck tool display.
NOTE: You may need to click the Trigger Once button for all getters to display.

=
g [Check  [View Index |Match Index|Match |Check Reai|Check Region Check Region Name Expected Actual  Passed  Chocolate_1
__EJ :DlChEcI-b\ﬂDlChecl- 0000/ 0.000/0ViDiMatch| 0.000/OVIDICheckRegion |Chocolate_2 | 1.000 0.000! 0.000! 0.000
10 | | | | 1.000/DVIDICheckRegion (Chacolate_1 [ 1,000 0.000 0,000 0000
1l 2 000/ DVIDICheckRegion |Chacalate_3 | 1.000 0.000 0.000 0.000
12| 3,000 DViDiCheckRegion |Chacalate_0 | 1.000 0.000 0.000 0.000)
= e [ [ | | | |
14 [ride al ~
16| | oom
NOTE: The information in the cells to the right of the Passed parameter is not going
to be used and can be deleted.
11. Right-click on cell M9 (the ViDiCheck Passed parameter) and select Publish from
the fly-out menu.
E. | Check Wiew [inciex Match IndexMatch 'C,heckF!eglcheckF!eqlnn [Check Region Name Expected  Actual [Pas @?I-:R.unmng
_gJ .DV\DIChEEFDVID\CHEEF.DVID!ChEEF. 0.000! 0 DUD.DVIDiMaTCh. 0.000DViDIChec kRegion .Chucuiatej 1 ODD_ 0.000}
10 1.000/0ViDiCheckRegion Chocolate_1 1.000 0.000
11| 2.000/OVIDICheckRegion Chocolate_3 | 1.000 0.000]
IQ. | 4 000 OViDiCheckRegion .Choco\am_tl 1 EIDEI_ 1] EID[I_
13 |Show
14 [ricean ] = | | | | ) Publish
15 4.000
A new Tag named Passed displays in the Properties panel.
12. Rename the tag to Result_Chocolate X.
NOTE: Review the Check Region Name parameter to select the correct chocolate #.
Cell Name
Image
Score
Menu
JobhTime
13. Repeat this step for the 3 remaining chocolates, again consult the Check Region
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Name parameter to select the correct chocolate #:

e CellM10
e Cell M11
e CellM12
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14. Enter ‘Total in cell L13 and an And statement in cell M13 (And(M9:M12)).

-
8 | [Check  [view index |Match IndexMatch |Check Regi[Check Region Check Region Name Expected  Actual |Passed
al |OViDiCheckHD\VIDICheckOVIDIC heck| 0.000] 0.000/0ViDiMatch| 0.000/0ViDiCheckRegion |Chocolae_2 | 1000 0,000 0,000,
10l I I I I I I 1.000/0ViDICheckRegion Chocolate_1 | 1,000/ 0.000/ 0,000,
1l [ I I I I [ 2.000/DViDICheckRegion |Chocalate_3 | 1,000/ 0,000/ 0.000,
12| | [ [ [ [ [ 3 000/OVIDICheckRegion |Chocolate_0 | 1000, | A
13| [Show | [ [ [ [ [ | Total 0.000

15. Navigate to the Main tab.
16. Enter a Ellipse on the Main page.
NOTE: The Ellipse is found in the Toolbox under Graphics 2 Ellipse.

Score 95.070

Menu hide all

JobTime 459756 93¢

Appearance
Fill Color

Line Color

The Expression Builder displays.
Expression Builder (Fill Color, CjsColor)

| Help

Validate

Tag Selector

Insert
Tag
Constant

Function

Cancel

18.  Click the Tag Selector IR b tton.
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The Tag Selector dialog displays. Only WebPages displays.

Tag Selector

E B Filter By Name:

Address

b () WebPages

19. Check the Show All Types checkbox at the bottom of the dialog.

4

* Show All Types

20. Navigate to Tasks 2> Inspection Task > Spreadsheet > Results_Chocolate_0

Accept

and click the Accept button.
NOTE: You can also type $Tasks.InspectionTask.Spreadsheet.Results _Chocolate_0
directly in the Expression Builder to build the expression.

21. The Type mismatch dialog displays. Click the Yes button to continue.

Type mismatch

Q Type doesn't match, are you sure you wish to continue?

The Expression is built.

Expression Builder (Fill Color,
Help
Validate
Associations
Tag Selector
Insert
Tag
Constant

Function

Cancel

Associations

22. Click the Associations button.
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The Binding Associations dialog displays.

Add Association

0.000| 5

Current Associations

Accept Cancel

Accept

23. Build your Association and click the Accept button.

Binding Associations
Add Association
0000 -
Current Associations
1 Green

0 | Red

Accept Cancel

24. The Association is built, click the OK button to close the Expression Builder.
25. Copy the ellipse and paste it next to the first.

NOTE: This will copy your association and bring it into the new ellipse.

26. Open the Expression Builder and change the expression to Chocolate_1. Click the
OK button to close.

Expression Builder (Fill Color, CjsColor)
Help

Validate

@ Associations

27. Repeat for the remaining chocolates.

There are now 4 circles on your webpage.

28. Add a label to each ellipse to identify a chocolate region. Label the ellipses in the
same order as the Layout Model that you created.
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NOTE: The label is found in the Toolbox under Data Display. Toolbox = Data Display
- Label.

Chocolate 2 || Chocolate_1

Chocolate_3 | | Chocolate_0

NOTE: This is a suggestion. Arrange the ellipses on the webpage as you would like.
29. Return to the Spreadsheet tab. We will add some logic to let us know when the
chocolate is in the correct spot in the assortment.
30. Enter the text in the following cells:

e Cell N8 = Chocolate 0
e Cell O8 = Chocolate 1
e Cell P8 = Chocolate 2
e Cell Q8 = Chocolate 3

e Cell R8 = Which Chocolate?
Press the <Enter> key after each entry

J Check View Index Match Index{Match Check Regi/Check Region Check Region Name Expected  Actual Passed Chocolate_0 |Chocolate_1 (Chocolate_2 (Chocolate_3 [Which Chacalate?
g. .:I\".EIIChE[l.EIVJDIChE[LEI\"}D\ChE[\- 1] nnn. [i] DUDIEIV\Dll\AaIEh 0.000BVIDIChec! 1.000 0000 1] .:-nn‘
Gl | | | | 1.000/IViDiCheckRe; 1000, 0000  0.00g)
n 2.000/0ViDICheckRe 1.000 0.000 0.000)
12_ | | | | 3.0002ViDIChec | 1.000 0.000 o -BDD‘
13 Show Total 0.000

31. Enter a GetFeatureCount function in cell N9, in this spreadsheet it will reference
cells 112 and N8. GetFeatureCount(19,N8).
NOTE: The first cell referenced for Chocolate 0 is the Cell for its ViDiCheckRegion,
and the second cell referenced is the Name of the Chocolate (that you entered).
e Cell O9 = GetFeatureCount(110,08)
e Cell P9 = GetFeatureCount(l111,P8)
o CellQ9 = GetFeatureCount(112,Q8)

32. Repeat step 31 for the remaining chocolate rows.

33. Click the Trigger Once & button to view the resuilts.

Check  View Index Match IndexMatch Check Region Index Check Region  |Check Region Name [Expected  |Actual Passed  [Chocolate_0 |Chocolate_1 (Chacolate_2 [Chocolate_3 Which Chocolate?
OVIDICheck OVIDICheckDVIDICheck 0.000 0.000 DViDiMatch 0.000 OVIDICheckRegion (Chocolate_2 1.000 0.000] 0 an 0.000 0.000 0.000; 0.000
1.000 OWiDICheckRegion (Chocolate_1 1.000 0.000; [} Dﬂq 0.000 0.000 0000 0.000
2000 OVIDICheckRegion |Chocolate_0 1.000 1.000 1 DBD‘ 1.000 0.000 0000 0.000
3000 0¥IDICheckRegion [Chocolate_3 1.000 0.000; 0.000, 0.000 0.000 0000 0.000
Show Total 0 EIUIJ‘

34. Next, we will add the logic to determine which chocolate is in each spot. Enter the
following formula in cell R9, If(N9,N8,If(09,08,If(P9,P8,If(Q9,Q8,"NONE”))))
35. Repeat step 34 for the remaining chocolate cells.
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36. Click the Trigger Once H button to view the results.

Check  view index  |MaichIndexMatch |Check Region Index CheckRegion [Check Region Name Expected |Actual  [Passed  [Chocolate_0 [Chocolate_1 [Chocolate_2 [Chocolate_3 [Which Chocolate?
OVIDIChechoViDIChechOVDIChech  0000| 0,000 SviOMatch 0,000/ BVIDICheckRegion (Chocolate_2 1000 0000 0000 0.000 ooos]  ooon|  ooooSORE
| | | 1,000 OVIDICheckRegion [Chocolate_i tooo 1 DUD: 1 DEID: 0.000. 1.000) 0.000] 0.000 Chocolate_1
2000 DViDICheckRegion (Chocolate_0 1000 1000 1o0g) 1,000, 0.000 ooon|  0000/Chocolate_0
3000 OVDICheckRegion [Chocolate_3 1000 oo 1000 0.000 0000 0.000 1,000 Chocolate_3
Show | Total 0,000

37. Publish cell M13 and name the Tag Results _All.
38. Navigate to the Main tab.

39. Add a rectangle around the four chocolate circles.

NOTE: This rectangle has been placed on top of the current rectangles.
Right-click > Send to Back > Send to Bottom.

i | Chocolate_2 || Chocolate_1

Chocolate_3 | | Chocolate_0

Send Backward

Send to Bottom

Appearance

Fill Color I Transparent

Line Color I #rracs

The Expression Builder displays.
n Builder (Fill C

Help

Validate

Tag Selector

Insert

Tag

Constant

Function
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Tag Selector

41. Click the Tag Selector button.
The Tag Selector dialog displays. Only WebPages displays.

Tag Selector

[ =B Filter By Name:

Address

b [} WebPages

42. Check the Show All Types checkbox at the bottom of the dialog.

a4

* Show All Types

43. Navigate to Tasks - Inspection Task > Spreadsheet > Results_All and click the

Accept

Accept button.
NOTE: You can also type $Tasks.InspectionTask.Spreadsheet.Results_All directly in
the Expression Builder to build the expression.

44. The Type mismatch dialog displays. Click the Yes button to continue.

Type mismatch

Q Type doesn't match, are you sure you wish to continue?

o

The Expression is built.

Expression Builder (Fill Co
$Taxkn. TnipectionTad adsheet.Results_All S
Validate
@ Associations
Tag Selector
Insert
Tag
Constant

Function

Cancel

Associations

45. Click the Associations button.
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The Binding Associations dialog displays.

Current Associations

Accept Cancel

button.

Accept Cancel

Appearance

Fill Color I Transparent

48. Return to the spreadsheet, open cell A0 (Image) and set the Trigger Mode to Timer
Interval and the Timer Interval parameter to 500ms and click the OK button.

Spreadsheet - Property Sheet - Acquirelmage

Edit Insert Help

Trigger Mode Timer Interval

Trigger Interval

49. Save your job as ViDiCheck_ChocolatesHMI in the folder created in lab #1.
50. Click the Online button to go Online.

File Edit View Job

Bl MEZ.

B2 Spreadsheet Main
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51. Click the Home tab to return to the ISVS home page.

LC'E] In-Sight Vision Suite ) ViDiDetect_AirFiltersHMI@usna-2313-10¢ X

File Edit View Insert Format Image Job Tools Network Help

52. Click the Open HMI button.

I3

Open HMI

The HMI will open in a browser. Scroll through the images and review the results.
53. Click the Offline button to go Offline.

File View Job Tools MNetwork Help

O Offline _

Spreadsheet Web HMI X

54. Click the Save All button to save your job.

File Edit View Job Tools Network Help

Al ™3 < = @Verify [ Online _

Spreadsheet Main X
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If time allows:
1. Navigate to the Spreadsheet tab.

2. Highlight cells J8 through R13.

Check Region Index|Check Region [Check Region Name [Expected  |[Actual FPassed Chocolaze_l}lcmcnlm_l |{Chocolate_2 |Chocolate_3 (Which Chocolate?
— A - A —— A . - 4

D.GDD:DVIDiCheCkREgJDH Chocolate_2 1000 0000 0.000 0.000, 0.000] 0000 U'E{n'u‘:'r'iqp_l_E_

1,000 OVIDICheckRegion [Ehacolate_| | 1o oooo]  ooog) oom)  0o0g) 0.000] 0 000)NONE

2,000 OVIDICheckRegion [Chaslate_ ! 1000  0000]  ooog) 0.000 0000 0000 0.000NONE

3.000/0ViDiCheckRegion RS 4100y 000G 000Q) 0000, 000G)  000Q)  OO0QNONE
Total 0000

3. Right-click and select Create a WebPage from Selected Cells from the fly-out.

A new WebPage is created.
Web Pages

EJ B Filter By Name:

i = CamOSetup
1 him Main
i = WebPage

4. Highlight all items on the new WebPage.

E Spreadsheet Main [E WebPage x

. 'Y e ']

5. Change the Border Color to Blue, Border Size to 5, Font Size to 72 and Text
Alignment to Center.

Frequently Used
Border Color
Border Size
Font Size
Icon

Text

Text Alignment Center
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6. Change the Background Color to White.

Check Region - .
Which Chocolate
Chocolate_2 NONE

Chocolate_3 Chocolate_3

7. Right-click on the WebPage, rename to Table and click the Accept button.
Rename

Enter a new name for the WebPage.
Table

Cancel

8. Add a button to the webpage.
NOTE: The button is found in the toolbox under User Inputs.

’....._.._.I
# Button &
- S

9. In the Properties, set the Click Command to HMI.ShowPage, set the pageName to
Main, and change the Text to Go to Main Page.

Click Command HMI.ShowPage
pageName Main

lcon

Text Go to Main Page

10. Format the text color and background color as you choice.

Note: This button has a background color of black, text color of yellow, font size 18
and the text is centered on the button.

1 Which Checolate?

Chocolate_3 Chocolate_3

Go to Main Page
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11. Repeat steps 8 — 10 to add a button to the Main webpage.
e Click Command = HMI.ShowPage
e pageName = Table
o Text = Go to Table Page
NOTE: You can also copy and paste the button from the Table page and change the
pageName and Text.

12. Click the Online button to go Online.

File Edit View Job Tools Network Help

Bl M2, @veity DOniine QD @ W E 0% B

Spreadsheet Main X [E Table
13. Click the Home tab to return to the ISVS home page.
[633 In-Sight Vision Suite ) ViDiCheck_ChocolatesHMI@usna-2313-1 X

File Edit View Job Tools Network Help

14. Click the Open HMI button.

!

Open HMI

The HMI will open in a browser. Scroll through the images and review the results.
15. Click the Offline button to go Offline.

File View Job Tools MNetwork Help

O Offline _

Spreadsheet Web HMI X
16. Click the Save All button to save your job.

File Edit View Job ls  MNetwork Help

B@ [ 2_ @veity Donine _ D §

Spreadsheet Main X
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At the end of this lab exercise, Participants will be able to:
o Utilize the utilities available in In-Sight Vision Suite to finish deploying the application

The Participant will utilize the following In-Sight Vision Suite Functions to successfully
complete this exercise:
e User Settings
Update Firmware
Network Settings
Backup
Restore

NOTE: In order to complete this lab exercise, you should not be connected to your camera or
emulator. This will allow you to access the Ultilities.

User Settings

Follow the steps below to complete the lab exercise:
1. Click on the User Settings link — this is found in the Utilities menu.

User Settings

The User Settings dialog displays.

User Settimgs

Configure the user settings for isd205m_Jennifer

Mame &  Access Level Comment

admin Full

Cancel

2. A user with the Name admin should already be there, with Full access. Click the
Add button to create a new user.
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A new line displays.

User Settings

Configure the user settings for isd905m_Jennifer

4 Access Level Comment

Delete

Full
Change the user settings:
User Name: fault Password:
Access Level: Full ~  Confirm Password:

Comment:

3. Enter the new user’s information in the appropriate fields and click the OK
button.
NoTE: Create two new users, one with Protected access and one with Locked
access. Choose the names you would like, use the password Cognex for both.

User Settings

Configure the user settings for isd305m_lennifer

MName 4 Access Level Comment
admin Full
Bob Locked

Jenmnifer Protected

Cancel

4. Connect to your camera. (if there is a job open on your camera, close it and open a
new job).
5. Click the Main WebPage tab.

6. From the Job menu, select Settings from the drop-down list.

File Edit View Job Tools MNetwork Help

Bl M2 @ Vey

Online  F5

[
[ Spreadsk
E{l Settings
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The Job Settings dialog displays.
7. Click Web HMI Settings and check the Enable Built-in Authentication checkbox.
Job Settings

Online » Enable Built-in Authentication

Security ¥ Inactivity Timeout 10 = | (min)

Web HMI Settings

Cancel

8. Click the OK button.
9. Click the Online button to go Online.
File Edit View Insert Format Image Job Tools MNetwork Help

Bl (B[2, ; @Veily D Online _
] Spreadsheet x [E Main

10. Click the Home tab and click the Open HMI button.

E’g In-Sight Vision Suite ) [Unsaved Job )05m_Jennifer X

Open HMI

11. A new web browser opens — login as admin (with no password)

Username  admin

Password
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12.

13.

Page 106

Log into the HMI with the other users that you created.

Notice the difference in the access that the different users have based on their
access levels.

Return to your camera and click the Offline button to go offline. Do not save the job.

EB] In-Sight Vision Suite % [Unsaved Job]@isd905m_Jennifer X

File View Job Tools Metwork Help

O Offline =
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Firmware Update

NOTE: In this lab, you will look at the steps needed for a firmware update to the
Controller and cameras, but you will not actually do an update.

1. From the Utilities tab select Firmware Update.

{i}

Firmware
Update

The Firmware Update dialog displays.
2. Select the Firmware version from the Update to: drop down list.
Firmware Update
Ready to update devices. Press Update to begin, cancel to close without updating.

Update to: In-Sight ViDi 2.2.0 (770} ~

Host Name Firmware Version Status

isd905m_lennifer 2.2.0 (645) Offline

¥ Backup Force Update
Update

3. Do not actually do an update, but if you were, highlight the camera to be updated
Update

and click the Update
available).

button. (In this screenshot there is only one camera

Firmware Update
Ready to update devices. Press Update to begin, cancel to close without updating.
Update to: In-Sight ViDi 2.2.0 (645) ~

Haost Name Firmware Version Status

isd905m_Jennifer 2.2.0 (645) Offline

¥ Backup Force Update

Cancel

The Update will begin.
4. Click the Cancel button to exit from this dialog.
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Network Settings
1. From the Utilities tab select Network Settings.

Host Name: _ ennifer Host Name:

Address Assignment: ® Auto (DHCP) Static Address Assignment: Auto (DHCP) @ Static

IP Address: IP Address: 169 . 254 . 114 . 164

Subnet Mask: Subnet Mask:

Default Gateway: Default Gateway:

DNS Server: DNS Server:

Domain Name: Domain Name:

Copy PC Network Settings

Cancel

2. Review the settings.
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Backup
1. From the Utilities tab select Backup.

&

Backup

The Backup dialog displays.
Backup

Ready to backup devices. Press Backup to begin, cancel to close without backing up.

Host Name Firmware Version Status

isd905m_Jennifer  2.2.0 (645)

Backup Cancel

Backup

2. Select the camera to backup and click the Backup button.

Close

3. Once the Backup is complete click the Close button.

Backup

All backups have been completed.

Haost Name Firmware Version Progress Status

isd205m_Jennifer 2.2.0 (645) I Backup complete
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Restore
1. From the Utilities tab select Restore.

The Restore dialog displays.

Restore
Restore isd905m_lennifer
Host Name: 1sd905m_Jennifer
Backup:
Show all backups:
Restore Network Settings:

Restore Cancel

NoOTE: If you want to see all the backdps available on the network check the Show all

backups checkbox.
2. Select the Backup that you would like to restore the camera from and click the

Restore

Restore button.

Close

3. Once the Restore is complete click the Close button.

Restore

Restore complete
Host Name: isd905m_lennifer
Backup:

Show all backups:

Restore Network Settings:

1sd905m_Jennifer (00-d0-24-3d-ff-94)

Restore complete
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Objective:
In the Final Lab Exercise will allow the student to tie together all the training that was
learned over the course of the two day In-Sight Vision Suite Standard class.

There is a lab for each of the In-Sight ViDi tools: ViDiDetect, ViDiCheck and ViDiRead.
You will select a lab for one of the tools and complete it, inclusive of creating an HMI.
If you have completed the lab and still have time available select a different tool and
work on solving that lab also.

You will notice that the labs are not written step by step as they were during the class
— this will allow you to come up with your own solution to the lab. There will be more
than one solution for each lab exercise, so allow your creativity to shine through. Be
prepared to discuss how you solved the lab with the class.

The images for each lab exercise can be found in the In-Sight Vision Suite folder in
the Student Folder on the desktop of the computer or laptop.

Before You Start:
Create a folder named In-Sight Vision Suite Final Lab within the folder that you created
in the first lab of the class.

Contents:
- ViDiDetect Lab

o Glass Vial Images
- ViDiCheck Lab

o Medical Kit Verification Images
- ViDiRead Lab

o Phone Back OCR Images

Goal:
The goal of each lab exercise is to utilize the In-Sight ViDi tool and show the good
part and the bad part and why it either passes or fails.
Also, an HMI should be created including graphics showing why the part passes or
fails.
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Final Lab Exercise 1 — ViDiDetect Tool

Images Needed:
- Glass Vial Runtime Images

- Glass Vial Training Images

Emulator:
- In-Sight D905M

Part to Inspect:
- The challenge is the transparent part makes it difficult to distinguish breakage from

debris along the front or back. The reflective surface also creates variability that would
challenge tradition rules-based vision.

Goal:
- Use the ViDiDetect tool to accurately distinguish natural part variation from anomalies

within the glass vials
- When complete save the job as ViDiDetect Final in the folder created in lab #1

- . 1
— - . il T S

Good Part Bad Part
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Task Inspections:

1. Consistently find the part in the image.

2. What tools did you add to your spreadsheet to find the part in the image?

3. Did you change any parameters in the ViDi Editor? If so, what did you change and to
what?

4. Create an HMI that shows the status of all the inspection tasks and the status of the
overall inspection.
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Final Lab Exercise 2 — ViDiCheck Tool

Images Needed:
- Medical Kit Verification Runtime Images
- Medical Kit Verification Training Images

Emulator:
- In-Sight D905M

Part to Inspect:
- The challenge is that the elements must be identified through a transparent medical
bag, which can be reflective and obscure the appearance of the elements.

- Use the ViDiCheck tool to find the bag within the frame and determine if the four
required features are present.

- When complete save the job as ViDiCheck Final in the folder created in lab #1.

We are looking for 4 items in the Medical Kit:
1. Clip

2. Scalpel
3. Syringe
4. Pigtail

All 4 parts must be in the kit in order to be considered a good part. If 1 or more part(s) are
missing, then that is to be considered a bad part.
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Task Inspections:

1. Consistently find the part in the image.

2. What tools did you add to your spreadsheet to find the part in the image?

3. Did you change any parameters in the ViDi Editor? If so, what did you change and to
what?

4. What did you use to find all four of the parts within the Medical Kit?

5. Create an HMI that shows the status of all the inspection tasks and the status of the
overall inspection.
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Final Lab Exercise 3 — ViDiRead Tool

Images Needed:
- Phone Back OCR Runtime Images

- Phone Back OCR Training Images

Emulator:
- In-Sight D905M

Part to Inspect:
- The challenge is that there are varying font and character sizes on a complex textured
background creating a difficult application for traditional OCR.

- Use the ViDiRead tool to accurately read the letters in a wide range of lighting and
background conditions.
- When complete save the job as ViDiRead_Final in the folder created in lab #1.
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Task Inspections:

1. Consistently find the part in the image.

2. What tools did you add to your spreadsheet to find the part in the image?

3. Did you change any parameters in the ViDi Editor? If so, what did you change and to
what?

4. Create an HMI that shows the status of all the inspection tasks and the status of the
overall inspection.
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